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Welcome to the DataMaster™
Bluetooth® Reader System
The Rapid RH® DataMaster™, with its innovative Bluetooth® 
Reader, ensures complete data integrity for the most comprehen-
sive in situ concrete relative humidity testing system available to-
day, the Rapid RH® 4.0. Using innovative technologies, operators 
can record and report complete testing results from each Job site 
for fully ASTM F2170-compliant Job-site testing and reporting.  

With the Rapid RH® tradition of accuracy and efficiency, the 
DataMaster™’s compact design, with touch-screen data record-
ing and complete Job-site records, make the Rapid RH® Data-
Master™/Bluetooth® Reader system a must for any concrete and 
flooring professional.

IMPORTANT NOTE: A DataMaster™ unit and a Bluetooth® Read-
er must be “paired” to allow communication between the two (see 
the section in this manual “Pairing a Bluetooth® Reader and Data-
Master™”).  

Your DataMaster™ unit and a Bluetooth® Reader combination has 
already been paired at the factory, and should not require another 
pairing-up process, but if you are not able to successfully acquire 
readings, you may have to perform the pairing process.

It is also important to note that your 
DataMaster™ is compatible with any 
Bluetooth® Reader but can only be 
paired with one Bluetooth® Reader at 
a time.  

Welcome to a new era of data integrity 
for accurate and efficient RH testing for 
concrete. 

TIP: To geT sTarTed quIckly, refer To The daTaMas-
Ter™/BlueTooTh® reader quIck sTarT guIde.

Initial Battery Charge
Your DataMaster™ requires an initial charge to have a fully oper-
able battery capacity. To charge the DataMaster™, connect the 
included USB cable to the port at the base of the unit and then to 
a computer USB port or AC USB adaptor (not included). Allow 2-3 
hours for the initial charge.

Your Bluetooth® Reader is powered by two, AAAA batteries.  The 
Reader uses very little energy. Its sophisticated power-saving logic 
will greatly lessen the frequency of battery replacement.
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Hardware Layout of the DataMaster™

A. Touch screen     D. SD card slot (on side)
B. USB port (on bottom)        E. Ambient RH/Temp sensor
C. On/Wake-Up button (on top)    F. Hard reset hole

A. Touch Screen Display: This is the convenient user interface 
for the DataMaster™. 

B. USB port: This port serves a dual function: 1) For use when 
charging of the DataMaster™ internal battery; 2) For connecting 
to a personal computer to upload sensor data to the f2170reports.
com web site. 

C. On/Wake-Up button: The DataMaster™ power-saving fea-
tures include automatic screen dimming and sleep mode based 
on no touch screen activity.  After 60 seconds of no activity, the 
screen’s backlight will dim.  Touching the screen turns it back on.  
After 5 minutes of no activity, the DataMaster™  will go into a low-
power sleep mode.  Touching the screen wakes the unit up.

D. SD card slot: The SD card stores the data you acquire.  The 
DataMaster™ cannot take or store readings without an SD card in 
this slot. The largest size SD card supported is 2 GB. 

E. External (Ambient) RH/Temp Sensor:  The relative humidity 
(RH)/temperature sensor monitors the ambient (room) conditions.  
When you take a reading, the ambient RH and temperature are 
acquired and stored with that set of readings for that Smart Sen-
sor.  This information is required for correct ASTM F2170 reporting 
protocol.

F. Hard Reset hole:  If your DataMaster™ becomes unresponsive 
(locked-up, etc.), just use a small diameter (one end of small paper 
clip, for example) tool to insert and push into the hole which will 
reset the unit.  If you perform this reset function, you will need to 
reset the Date/Time for your unit.

Main Menu
Once powered up with the On/Wake-
Up switch, the Main menu will display 
in the window. Main menu selections 
include View, Graph, Tools and Set-
tings. We recommend beginning with 
the Settings Menu. A Quick Start guide 
is available for the initial unit settings 
and function.

Battery-level icons and a Bluetooth® 
communication icon may appear in the 
Main Menu title bar (and on some other 
DataMaster™ screens as well). 

The left-hand battery icon shows the last charge level indicated 
for your Bluetooth® Reader.  If this icon is not present, it will again 
appear when you take a reading with the Reader.  The battery icon 
on the right-hand side is for the DataMaster™ device.

If the Bluetooth® communication icon is not present in the title bar, 
this indicates the Reader is powered off.  To “turn on” Bluetooth® 
communication, try to take a reading in a Smart Sensor.  During 
this “power on” period, it can take from 3 to 7 seconds for the 
Reader to initially connect to the DataMaster™, at which time the 
Bluetooth® communication icon will appear in the title bar.  

So long as the DataMaster™ is on, and less than 5 minutes has 
elapsed from the last sensor reading, the Reader will stay “con-
nected/powered on” and the communication icon will indicate this.  
The Bluetooth® Reader will turn off if left idle for 5 minutes.

If the Bluetooth® icon is in the title bar, the Bluetooth® Reader is 
powered on and should take 2-3 seconds to acquire a reading. If 
you don’t get a reading within 2-3 seconds when the Bluetooth® 
icon is present, then you likely do not have a good connection 
between the Reader and the Smart Sensor.  Remove your Reader 
and reinsert into the sensor. See our Trouble Shooting Guide if 
further difficulties persist.

Settings Menu
From the Settings Menu, select from a 
sub-menu of options including About, 
Units, Graph Scales, Date/Time, 
Touch-screen Calibration, Backlight & 
Sound and Battery.  When powering up 
for the first time, users should access 
the Settings Menu to set the defaults 
before testing.   

NoTe: PressINg The hoMe IcoN oN aNy 
screeN wIll Take you Back To The MaIN MeNu.
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Units Setting 
Choose the units used to record the 
temperature and depth of the drilled 
hole.

1. From the Settings menu, select the 
Units option.  

2. Select either Fahrenheit or Celsius. 
3. Select either Inches or Millimeters.
4. Select OK.

NoTe: chaNgINg The uNIT seTTINgs afTer 
daTa has BeeN recorded wIll auToMaTIcally 
coNverT all readINgs oN The daTaMasTer™ 
To The selecTed uNITs.

Graph Scales Setting

Recorded data can be viewed with cus-
tomized scale and graph view on the 
DataMaster™ unit. 

1. From the Settings menu, select the 
Graph Scales setting.  

2. Set the Min RH and the Max RH. 
3. Set the Min Temp and the Max 

Temp.
4. Set the Target RH.
5. Select OK.

Date/Time Setting

1. From the Settings menu, select the 
Date/Time option.  

2. Set month, day, year, hour, minute 
and second by touching the appro-
priate box and using the up or down 
arrows at the bottom of the screen 
to select the correct number.

3. Select OK when finished.

Setting the correct Date and Time is vital to ensure that all data is 
accurately recorded as being within the selected time and date for 
a Job.  All data records are date and time-stamped accordingly for 
specific recordkeeping, and the date and time displays when view-
ing the results of a particular test. 

Touch-screen Calibration 
Touch-screen Calibration on each 
DataMaster™ unit has been carefully 
completed prior to shipping. We rec-
ommend NOT using this feature un-
less absolutely necessary.  

For precision, use a stylus or pencil 
eraser tip when performing this opera-
tion, and follow the onscreen directions 
exactly.  

Backlight and Sound Setting
Users can customize the display bright-
ness and audible indicator.

1. Select the Backlight and Sound 
Setting option.  

2. Select and slide the sliding bar to 
the left or right for the appropriate 
Backlight percentage setting.

3. Select the Sound as On or Off.
4. Select OK.

NoTe: BaTTery lIfe caN Be exTeNded By de-
creasINg The BacklIghT BrIghTNess.

The Battery
The Battery option indicates the battery 
charge level in both the unit’s battery 
and the paired  Bluetooth® Reader.   

To charge the battery, use the USB 
cable and connect it to any computer 
USB port or USB power-source adap-
tor.  A pop-up screen will display the 
unit charge level.

Return to the Settings menu by select-
ing the “back” arrow.  

The Tools option is available to users 
from the Main Menu of the unit.  Once 
the Tools option is selected, the Tools 
menu displays and users can select 
from the following options: Add Job, 
Delete Job, Delete Sensor, BT Read-
er, and Format Card.

Tools Menu
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Add Job  
1. From the Tools menu, select Add 

Job.
2. Enter the name or number using 

the touchpad. 
3. Select OK to store the information 

into memory for easy retrieval.

NoTe: JoB NaMes caN Be a MaxIMuM of 8 
alPha-NuMerIc characTers. MulTIPle JoB 
NaMes caN Be added aT aNy TIMe. The JoB lIsT 
caN Be revIewed aT aNy TIMe By selecTINg 
“vIew” froM The MaIN MeNu.

1. Firmly insert the Bluetooth® Read-
er into a Smart Sensor.

2. Hold the Bluetooth® Reader in 
place for approximately 3 seconds, 
or until the reading acquired screen 
(shown below) appears, then re-
move the Bluetooth® Reader.

 
NoTe: May Take uP To 7 secoNds If Blue-
TooTh® coMMuNIcaTIoN has NoT BeeN INITIally 
esTaBlIshed (BlueTooTh® IcoN Is NoT Pres-
eNT IN TITle Bar).

IF Bluetooth® icon is already present in title bar, a successful read-
ing will usually occur within 2 seconds of Reader insertion.  If you 
do not get a successful reading, reinsert the Bluetooth® Reader.

After 3-4 seconds of displaying this screen, and if this is the very 
first reading for this sensor, you will be taken to the “Select a Job” 
screen where you assign this sensor to the appropriate Job from 
the Job list. 

Once you choose the Job, you will be 
taken to the Sensor Data screen where 
you will be able to view stored data for 
this first reading for this sensor. 

Next, you will enter other Sensor In-
formation, when the DataMaster™ 
acquires the initial (first) reading for a 
sensor.

Taking Readings

To enter sensor information:

1. From the Sensor Data screen, 
touch the “Information” button (“i” in 
a circle) on the bottom right corner 
of the screen.

2. On the “Sensor Info” screen (shown 
below), enter the sensor’s location 
(Loc:) on that particular slab and 
the Hole Depth, which are manda-
tory for correct reporting according 
to the ASTM F2170 reporting pro-
tocol. Floor, Slab and Slab thick-
ness are optional, but may be used 
to provide additional information if 
desired. 

3. Once the Sensor information has been entered, press the 
“back arrow” to return to the Sensor Data screen, or press the 
Home icon to return to the Main screen.

Once a sensor has been assigned to a specific Job, subsequent 
readings from that sensor will automatically be stored under the 
assigned Job. Sensors are non-transferrable between Jobs once 
assigned. 

Job site data can be viewed by selecting individual sensors from 
the sensor list for a Job. Sensor data can also be graphically 
viewed when you choose the “Graph” menu of the DataMaster™. 
Each reading for a sensor will record the current slab internal RH 
and temperature, sensor serial number, sample number (i.e. 2 of 
3), date, time, dew point (DP) and ambient RH and temperature.

Delete Job 
When data from a particular Job is no 
longer needed or has been uploaded 
from the DataMaster™, the Job name 
and records can be deleted from the 
unit. 

1. From the Tools menu, select Delete 
Job.

2. Select the name or number of the 
Job you wish to delete.

3. Select OK to permanently delete 
the Job from memory. 

NoTe: The JoB aNd ITs daTa wIll No loNger Be accessIBle oNce The JoB Is 
deleTed. oNce deleTed, The JoB daTa wIll oNly Be avaIlaBle If IT has BeeN 
uPloaded To The www.f2170rePorTs.coM weBsITe for archIvINg or asTM-
forMaTTed rePorTINg. fIles caN also Be TraNsferred froM The sd card To 
a Pc card reader for Back-uP, BuT ThIs MusT Be doNe Before The JoB Is 
deleTed Through The daTaMasTer™ uNIT.



8 9

Delete Sensor 
The Delete Sensor option enables us-
ers to remove any sensor data from 
any Job.

1. From the Tools menu, select Delete 
Sensor.

2. Select a Job.
3. Select the sensor you wish to de-

lete.
4. Select OK to permanently delete 

the sensor from memory. 

NoTe: seNsors are NoN-TraNsferraBle BeTweeN JoBs oNce assIgNed. se-
lecTINg The deleTe seNsor oPTIoN deleTes all seNsor daTa froM MeMory.  
oNce coMPleTed, The daTa Is losT aNd caNNoT Be reTrIeved aNd The seNsor 
caNNoT Be used for aNoTher JoB.

Pairing a Bluetooth® Reader and 
DataMaster™
A Bluetooth® Reader must be paired 
with the DataMaster™ before you can 
acquire readings. The BT Reader func-
tion pairs the DataMaster™ to a Blue-
tooth® Reader.  The DataMaster™ is 
compatible with any Bluetooth® Reader 
but can only be paired with one Blue-
tooth® Reader at a time.

1. From the Tools menu, select BT 
Reader. A new window displays 
stating the device is ready to take 
a reading.

2. Insert a Bluetooth® Reader into a 
Rapid RH® Smart Sensor.

3. Keep the Bluetooth® Reader firmly 
inserted into the Smart Sensor until 
you hear a beep, or the Bluetooth® 
Reader serial number displays on 
the window.  This may take up to 15 
seconds. 

 
 Once the pairing is established, the 

unit will return to the Main menu. If 
not, you will get an error message.

Format Card
The Format Card option allows users 
to format the SD card used for data  
storage. 

NoTe: uP To a 4gB sd card caN Be used for 
sTorINg daTa; uPdaTINg The daTaMasTer™ 
uNIT’s sofTware requIres a 2gB or less sd 
card.

From the Tools menu, select Format 
Card.
1. Insert the SD card into the slot  

located on the left of the unit.
2. Select Format.  Note: The unit will 

ask you to verify that you want to 
format the card. Once format is se-
lected, all exiting data on the SD 
card is erased.  

3. Select Format to proceed with 
formatting the SD card.  Note: All  
existing data is erased once  
Format is selected.

4. Select Format to continue, or Can-
cel to cancel the procedure.

With a successful pairing, the DataMaster™ is paired to the Blue-
tooth® Reader and available to retrieve data from any sensor as-
signed to the Job site (see Sensor Information, page 14).  Each 
sensor has a serial number and all data is stored according to that 
number. 

View Menu
The View Menu option allows users to 
select and view a Job that has been 
loaded into the unit from a site that 
has been tested or is in the process of  
being tested. 

1. From the Main Menu, select View.
2. Select a Job from the Select a Job 

menu.
3. Select the sensor to view its data

Sensor Data

Complete sensor data is available for 
each sensor assigned to a Job site. 
It can be accessed through the View 
Menu by selecting a Job name from the 
“Select a Job” menu, then choosing the 
desired sensor from the displayed list 
of sensors.

The field descriptions are as follows:
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RH: Displays the test hole’s relative humidity.
Temp: Displays the test hole’s temperature in Fahrenheit or 
Celsius.
Job: Displays the Job site by name.
Serial #: Displays the serial number of the sensor.
Sample: Displays the particular sample number for this data, 
and how many times you have taken a reading from that  
sensor.
Date: Displays the date the reading was taken.
Time: Displays the time the reading was taken in a 24 hour 
format. 
DP: Displays the dew point in either Fahrenheit or Celsius (F 
or C) depending on option chosen in Settings Menu).

Optional features are available at the bottom of the sensor data 
screen.  These icons, when selected, perform accordingly:

ICON NAVIGATION
Home Returns you to the Main menu.
Curved Back Arrow Retrieves the last screen displayed.
Back Arrow Returns to the previous set (sample) of 

readings for that sensor. (Appears when 
sensor has more than one reading)

Forward Arrow Takes you to the next set (sample) of read-
ings for that sensor. (Appears when sen-
sor has more than one reading and you’re 
not on most recent)

Circled ‘i’ Displays the entire Sensor Information 
window.  

Sensor Information 

For the initial (first) reading for any 
sensor, the Sensor Information screen  
allows you to enter (except for Ambient 
RH and Ambient Temp) key information 
of the description, location, type of floor, 
the type of slab and its thickness plus 
the depth of the test hole.  Some of this 
information is required if you plan to 
use www.f2170reports.com for storing 
data or for generating verified reports 
or ASTM-compliant reports.  Once this 
data is entered the first time for a par-
ticular sensor, this data will appear for 
that sensor on the Information screen.  
The field descriptions are as follows:

Desc: Displays the name of the Job.  
Loc: Displays the sensor’s location as entered for a particular 
Job.
Floor: Displays the floor type, if entered.

Slab: Displays any additional slab information entered 
Slab Thickness: Displays the thickness (if entered) of the slab 
(i.e. 3 inch, 4 inch, 5 inch). Measurements display down to 
tenths of an inch. 
Hole Depth: Displays the hole depth entered (i.e. 1 inch, 2 
inch).  Measurements display down to tenths of an inch. 
Ambient RH: Displays the ambient Relative Humidity per-
centage recorded in the area where the sensor was installed.
Ambient Temp: Displays the ambient temperature recorded 
in the area where the sensor was installed. 

Graph Menu
This Graph Menu allows users to select 
the type of graphical readings they wish 
to view. 

1. From the Main menu of the unit, se-
lect Graph.

2. Select the Job to view its graphical 
readings.

Optional features are available at the 
bottom of the screen.  These icons, 
when selected display the following 
screens:

ICON NAVIGATION
Job Displays Job selection screen to choose data 

you want to view.  Once selected, the screen 
displays from 1 to 12 sensors per screen. The 
screen displays most recent data in a bar graph 
or the trend history as a line graph if selected.

Graph Allows users to change the graph from bar 
graph to line graph.

RH Displays the relative humidity in a graphical for-
mat.

Temp Displays the temperature in a graphical format.
Dew Point Displays the Dew Point in a graphical format.
Home Returns you to the Main menu
Target RH Displays the limit as a line within the graph. The 

Target RH is set within the Settings menu.
Forward Arrow Displays the next screen.
Back Arrow Returns to the previous screen.
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Using www.f217reports.com
To begin, you must first create a unique user account for  
storing your data and creating reports. The sign up option is avail-
able on the site’s home page. Please provide all information that is 
required. Once your user account is created, begin uploading test 
data from your RapidRH® DataMaster™.

Uploading Data

Login to your account on the web site and select “Reports”. 

When prompted to upload your files, connect the DataMaster™ 
to your PC’s USB port using the USB cable. The DataMaster SD 
Card will appear as a “thumb drive” on your PC. Alternately, insert 
the SD card from your DataMaster™ into the slot on your comput-
er or any standard card reader connected to your computer. Next, 
click on “Upload Files” then select “Browse”, find the appropriate 
drive with your DataMaster™ data. (You can either upload a single 
file or a zipped file containing all the data files for a particular Job.) 
Select the file(s), then select “Upload.”

Generating ASTM F2170 Reports

Once the site has uploaded your data files, the results will be dis-
played on the screen. You now have an opportunity to retrieve the 
results in several different formats (PDF, Excel, or CSV format) for 
reporting, sharing, and archiving. Choose the format that works 
best for you, keeping in mind that the pdf file will be the report that 
conforms to the ASTM F2170 requirements.

To get a “Wagner Certified” indication on the report, all the final 
data taken from the particular Job’s sensors must fall within the 
time period prior to the sensors’ expiration dates. 

A help menu is also available on the web site to guide you with any 
questions you may have, or provides contact information should 
you need further assistance.  

PROBLEM WHAT TO DO
DataMaster™ will 
not turn on

Charge the battery using the USB cable; 
wait 20 min then try again

DataMaster™ will 
not link to BT-reader

Make sure the Data Master™ battery is 
charged. If it is, then change the batteries 
in the Bluetooth® Reader  and try again.

DataMaster™ will 
not let you input 
Jobs or data

Check to make sure that the SD card has 
been formatted and /or is unlocked and 
format or unlock as required. If neces-
sary, replace the SD card.

DataMaster™ locked 
up

On the back side of the unit there is a tiny 
hole / top left; insert a small pin to reset 
the unit.

DataMaster™ will 
not read SD card

Remove and re-insert SD card; if still not 
working replace with new SD card

Display malfunction-
ing

On the back side of the DataMaster™ 
there is a tiny hole / top left; insert a small 
pin to reset the unit. Recalibrate the dis-
play if needed.

Cracked display Return DataMaster™ to Wagner Meters 
for repair.

Troubleshooting



For more information on relative humidity testing 
and to order online go to

www.RapidRH.com

Wagner Meters
326 Pine Grove Road
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(800) 585-7629
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